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You can find, read, and/or download the most recent version of this document for free 

by searching for ‘Fritz 12 Quick Guide’ on the following sites: 
 

1. Google.com  (free searching for ‘Fritz 12 Quick Guide’) 

2. Issuu.com   (free viewing and downloading, must create a free account) 

3. PDF-Archive.com  (free downloading) 

4. Scribd.com   (free viewing, paid downloading, must create a free account) 

 

 

Please keep an eye on the following table in order to ensure you have the most recent version of this document. 

 
Revision 

Number: 

Date: Author: Description: 

1.0 12/21/2010 Daniel L.  Benway document creation 

1.1 12/21/2010 Daniel L. Benway added section on setting up a position 

1.2 12/22/2010 Daniel L. Benway added info on deleting a database, optimizing hashtables, setting board and piece 

color, explain all moves, and turning off the engine or entering ‘Infinite 

Analysis’ when entering a game into the computer. Added section on playing 

games against Fritz. 

1.3 12/22/2010 Daniel L. Benway added section for online tutorials and resources 

1.4 12/26/2010 Daniel L. Benway added info on the letters in the ‘Database’ window, added a section on training 

under Fritz, added the obscure chess annotation symbols 

1.5 1/2/2011 Daniel L. Benway added a section on the ‘Notation’ window. Added information on layouts and 

their quirky behavior. Added information about where Fritz saves games by 

default (AutoSave.cbh). Added a section on the openings book. 

1.6 1/3/2011 Daniel L. Benway added a section on vendors and products. Added information on ‘Deep Position 

Analysis’, analyzing multiple games in a batch, and the meaning of ‘B’ in the 

‘Main Engine’ window. 

1.6.1 1/9/2011 Daniel L. Benway minor updates to the ‘Notation Window’ section  

1.7 1/23/2011 Daniel L. Benway added a section on making Fritz play against itself 

1.7.1 1/24/2011 Daniel L. Benway added info on black moves in the ‘Openings book’ 

1.7.2 1/28/2011 Daniel L. Benway added info on annotating with colored arrows and squares. Added more info on 

the letters used to describe games in the ‘Database’ window (special thanks on 

additional letter info to F. Leon Wilson of www.ChessLearn.com). 

1.7.3 1/31/2011 Daniel L. Benway re-wrote the ‘General’ section. Clarified the USCFSales recommendations on 

hash tables. Added info on medals in the ‘Database’ window, and changed the 

verbiage regarding Fritz databases in general (special thanks on these last two to 

F. Leon Wilson of www.ChessLearn.com). 

1.7.4 2/5/2011 Daniel L. Benway troubleshot and found a workaround for the bug on selecting multiple games for 
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analysis in the ‘Database’ window 

1.7.5 3/6/2011 Daniel L. Benway added info on ‘Last move’ value of ‘1’ 

1.8 3/8/2011 Daniel L. Benway added info on the Chessbase product. Added info on database file structure and 

file extensions. Added info on sorting games within a database by date. Added 

info on database keys. 

1.8.1 3/9/2011 Daniel L. Benway added info on replacing games in your databases. Added info on making your 

archive database ‘per year’, and your working database ‘per month’. Added info 

that Fritz ‘keys’ might better be called ‘categories’. 

1.9 3/10/2011 Daniel L. Benway added info on ‘Blunder Check’ for analyzing games. 

1.9.1 3/12/2011 Daniel L. Benway cleaned up the process for analyzing games, and specified a new order for the 

steps thereof. 

1.9.2 3/22/2011 Daniel L. Benway added info on using the ‘*’ key to re-create the evaluation profile. Added 

clarification on ‘blunder check’ versus ‘full analysis’. Added clarification on 

‘Deep position analysis’. 

1.9.3 3/25/2011 Daniel L. Benway added info on saving ‘Deep position analysis’, ‘Blunder check’, and ‘Full 

analysis’. 

1.9.4 3/26/2011 Daniel L. Benway added info on storing the ‘Evaluation profile’. 

1.10 3/27/2011 Daniel L. Benway corrected errors regarding the colors of the ‘Evaluation Profile’ 

1.11 4/13/2011 Daniel L. Benway added a section on how to print a game 

1.12 5/1/2011 Daniel L. Benway title change of the ‘General’ section to ‘Freeware License and Disclaimer”, and 

the verbiage therein 

2.0 5/9/2011 Daniel L. Benway added ‘About the Author’ section, and ‘Special Mention’ section. Published to 

www.Scribd.com with an ad campaign on Google. 

2.1 5/9/2011 Daniel L. Benway added OhioChess.org to ‘Special Mention’ section 

2.2 5/22/2011 Daniel L. Benway added ‘Abstract & Keywords’, added ChessForums.org URL 

2.3 7/9/2011 Daniel L. Benway added info to ‘Detailed Position Analysis’ in ‘Analyzing a Completed Game’ 

section. Added diagrams and color highlights to the section on colored arrows 

and squares. 

2.3.1 7/9/2011 Daniel L. Benway fixed a typo 

2.3.2 9/17/2011 Daniel L. Benway explained how Fritz notates forced checkmates in the ‘Main Engine’ and 

‘Notation’ windows. Tightened the verbiage of those two sections. Added Steve 

Lopez to the ‘Special Mention’ section of this document. 

3.0 9/17/2011 Daniel L. Benway ‘Document Revision History Record’ was updated after I learned that 

Scribd.com was charging people to download this freeware document. The 

aforementioned section now contains information on other sites that people can 

use to read and/or download this document. 

3.0.1 9/18/2011 Daniel L. Benway updated the ‘Special Mention’ and ‘Document Revision History Record’ 

sections of this document, and made minor edits in the ‘Databases’ section. 

3.0.2 12/16/2011 Daniel L. Benway updated the ‘About the Author’ section 
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Freeware License and Disclaimer: 
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This document is freeware. You may distribute unchanged copies of this document freely to anyone at any time. 

Care has been taken to cite contributing sources and individuals, please do the same. 

 

This document is a quick guide to Fritz 12. It was written so that someone inexperienced with computers and/or 

Fritz 12 could start using Fritz 12 quickly and easily. Great care has been taken to ensure that this document is 

technically accurate, but Fritz 12 is a complex product that is not well documented internally or on the Internet. 

As such there may indeed be technical errors herein, but the author has worked hard to avoid them through care, 

attention, and research. Additionally, this document has not been painstakingly or professionally proofed, as the 

intent was to quickly better Fritz, chessplayers, and the art of chess itself, not dwell on minor edits, 

inconsistencies, etc.. 

 

About the Author: 
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Daniel L. Benway (a.k.a. Dan Benway) can be contacted via Facebook, LinkedIn, etc.. 

 http://www.facebook.com/dan.benway  

 http://www.linkedin.com/pub/dan-benway/7/b56/b36  

 

http://www.facebook.com/dan.benway
http://www.linkedin.com/pub/dan-benway/7/b56/b36
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Special Mention: 
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 F. Leon Wilson (www.ChessLearn.com) gave me help and information on several features and uses of Fritz 

12 when I was stuck and couldn’t find the answers. 

 Chuck Diebert (www.ChuckDiebertChess.com) has been my coach since 2006. 

 Steve Lopez (www.USCFSales.com) wrote and published useful Fritz information on the Internet which 

I’ve included in this document with attribution. 

 Ohio clubs, coaches, events, etc. (www.OhioChess.org) 

 

 

Online Tutorials and Resources: 
(CTRL + Left Click here to jump back to Table of Contents) 

 

 http://shop.ChessCafe.com/images/products/software/Fritz12manual.pdf  

 http://USCFSales.com/Main/freeguide  

 http://www.ChessBase.com/support  

 http://www.ChessForums.org  

 http://www.YouTube.com  

 http://www.Google.com  

 “Insider's Guide to Revving up Your Fritz 12” is something I’ve heard of but can’t find 

 

 

Vendors and Products: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 Aquarium - a chess user interface made by ChessOK 

 Chessbase - a German company which makes chess playing and learning software, including Fritz. 

Chessbase is also the name of Chessbase’s chess database product. 

 ChessMaster - a chess user interface and engine written by UbiSoft 

 ChessOK - a Russian company (formerly known as Convekta) which makes chess playing and learning 

software 

 Convekta - a Russian company (now known as ChessOK) which made chess playing and learning software 

 Deep Fritz - a multi-processor chess user interface and engine written by Chessbase 

 Deep Rybka - a multi-processor UCI chess engine written by Vasik Rajlich 

 Fritz - a single processor chess user interface and engine written by Chessbase 

 Iweta Rajlich - polish International Master, married to Vasik Rajlich 

 Rybka - a single processor UCI chess engine written by Vasik Rajlich 

 RybkaChess - the company that makes and distributes the Rybka UCI engine without the chess user 

interface 

 UbiSoft - a French company which makes a wide variety of video games, including ChessMaster 

 UCI - Universal Chess Interface - an open protocol that enables a chess user interface and a chess engine to 

communicate with each other 

 Vasik Rajlich - the creator of Rybka. He’s a Cleveland born MIT graduate with dual Czechoslovakian and 

American citizenship, grew up in Prague, now lives in Warsaw with his Polish wife Iweta Rajlich 

  

http://www.chesslearn.com/
http://www.chuckdiebertchess.com/
http://www.uscfsales.com/
http://www.ohiochess.org/
http://shop.chesscafe.com/images/products/software/Fritz12manual.pdf
http://uscfsales.com/Main/freeguide
http://www.chessbase.com/support
http://www.chessforums.org/
http://www.youtube.com/
http://www.google.com/
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Updates and Patches: 
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It’s critical to keep Fritz up to date for reasons of functionality, stability, and security. Do this step before doing 

anything else so you know you’re not wasting time with old versions with missing features or even bugs, and 

then check for updates frequently. 

 

Pull down the ‘Application Menu’, left click ‘Activation’, left click ‘Update Program’. 

 

 
 

 

When the update is done, pull down the ‘Application Menu’, left click ‘User Info’, left click ‘credits’, check 

that the date is fairly recent. 
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Options & Configurations: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

Note that the little arrow in the lower right of some ribbon categories means that there are more options: 

 

 
 

 

Set your board and piece color from the ‘Board’ tab. 
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Set up your general preferences by left clicking the ‘Application Menu’, then left clicking ‘Options’. 

 

 
 

 

The ‘Multimedia’ tab in the ‘Options’ window is especially useful. The ‘Clocks + Notation’ tab is explained 

under the ‘Notation Window’ section of this document. 
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‘Permanent brain’ and ‘Hashtable size’ should be turned on and adjusted respectively; both can be done from 

the ‘Main Engine’ window. The ‘Views & Layouts’ section, and the ‘Main Engine Window’ section of this 

document describe how to view and use the ‘Main Engine’ window. 

 

From the ‘Main Engine’ window, left click the name of the engine. Turn on ‘Permanent brain’, and set the 

‘Hashtable size’ per these instructions: 
 

http://uscfsales.com/Main/freeguide 
 
What is a Hash Table? As your chess software evaluates positions in its search for the best move, it stores all of 
positions that it has looked at (and their valuations) into a section of your computer's memory that is known as the 
Hash Table. If, in its future analysis of the game, if it comes across a position that it already evaluated as part of its 
search, it won't need to analyze it again.  The larger the Hash Table, the more positions it will be able to remember and 
the more deeply it will be able to calculate in a given amount of time.  
 
To configure the size Hash Table, press the F3 key on your keyboard to bring up the Load Engine window. At the 
bottom of this window is where you can set how much memory you want dedicated to the Hash Table. Remember, the 
larger the Hash Table the better, as long as you have enough memory on your computer to handle it. If you set your 
Hash Table too high, your computer will not be able to store that much data in your memory and will have to start 
storing it on the hard drive, which is much slower. We've all had times where we've tried to do something on our 
computer and the computer is unresponsive, yet we can hear our hard drive churning inside the PC. This is something 
you want to avoid. To accomplish this, we recommend that you set your Hash Table to be equal to 70% of your 
available memory. How do you find your available memory? [Close all applications, then] hit Ctrl-Alt-Del on your 
computer and then select the Performance Tab. This page will tell you how much Memory is available [when Windows 
is running all alone]. Once you have that figure, multiply it by 0.7 to determine the optimal size of your Hash Table.  
 
Please note that this 70% figure is a rule of thumb, and might not be ideal for every computer. If you follow these rules 
and still experience the hard drive churning sound and less-than-ideal performance, reduce the Hash Table a bit more 
until the hard drive access during play is gone. Once that happens, your Hash Tables will be the ideal size.  
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Views & Layouts: 
(CTRL + Left Click here to jump back to Table of Contents) 

 

 

From the ‘View’ tab, choose the windows you want to see. 

 

 
 

 

Right click in the ‘Notation’ window and choose whether or not you want to see ‘Material’ and/or the ‘Position 

Tutor’ in the ‘Notation’ window. 
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In the ‘Training’ tab, ‘Explain All Moves’ can sometimes be useful. 

 

 
 

 

When you have your windows arranged how you like them, you can save your pane layout from the ‘View’ tab, 

and load it whenever you want. 
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Frustrating things about layouts: 

 

1. The ‘Show Position Tutor’ option (on or off) in the ‘Notation’ window does not get saved into your 

layouts. 

2. The table color (maybe even board and piece color) do get saved into your layouts. 

3. The ‘Explain All Moves’ option (on or off) from the ‘Training’ window does not get saved into your 

layouts, but the location of the ‘Explain All Moves’ window does. Furthermore, the ‘Explain All Moves’ 

option gets turned off each time you start Fritz. What this all means is that if you have ‘Explain All 

Moves’ turned on and you save your layout, your layout will only look right when you turn on ‘Explain 

All Move’s, and your layout won’t look right if ‘Explain All Moves’ is turned off. 

4. If you have trouble loading your layouts, try hitting the ‘Standard Layouts’ button before you load your 

layout; this will reset the layout to a standard one so you can then load your own layout with fewer 

problems. If this doesn’t work close the main Fritz window and restart Fritz from the green startup 

menu. 
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I suggest creating at least two layouts: 

 

1. one layout for game play 

 

 
 

2. one layout for analysis/study with the ‘Explain All Moves’ pane, and the ‘Position Tutor’ in the 

‘Notation’ pane. 
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Databases: 
(CTRL + Left Click here to jump back to Table of Contents) 

 

In Fritz, a database is simply a place where games are stored, categorized, and searched. A game can be one 

you’ve played against Fritz, one you’ve entered from a tournament scoresheet, a series of moves you’d like to 

study (like a pet opening or defense), or a collection of games from a third party (such as ChessBase). 

 

When you’re playing a game against Fritz, it gets saved automatically in the ‘AutoSave’ database in 

MyDocuments\ChessBase\MyWork . 

 

On the ‘Home’ tab, left clicking the ‘Database’ button brings up the ‘Database’ window. The top of the 

‘Database’ window shows the name of the database you’re currently using. 
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In the ‘Database’ window, you can left click the database icon (in the upper left corner) to create a new 

database, open an existing database, save the current game to the current database, etc.. 

 

 
 

 

When you’re creating, opening, and saving databases be sure to notice the path so they get put where you want 

them and so they can be part of your regular computer backups. 
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When  you delete a game from a database, it doesn’t get fully deleted until you choose ‘Remove Deleted 

Games’. 

 

 
 

 

You delete an entire database from that database’s window, under ‘Database Functions’, ‘Delete Files’. 
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Each line in the ‘database’ window represents a game that is stored in that database. 

 

 
 

 

Each line contains (from left to right): 

 
 the players’ names and ratings 

 tournament info 

 annotator of the game in [brackets] 

 amount of time spent analyzing the game (in parentheses) 

 medals if the game was analyzed by Fritz (http://www.chessbase.com/support/support.asp?pid=227) 
o best game -- mustard 

o decided tournament -- pink/light purple  

o model game (opening plan) -- dark navy blue  

o novelty -- bright medium blue  

o pawn structure -- olive green  

o strategy -- khaki  

o tactics -- blood red  

o attack -- yellow  

o sacrifice -- bright red  

o defense -- white  

o material -- purple  

o piece play -- fluorescent green  

o endgame -- forest green  

o tactical blunder -- black  

o strategic blunder --grey  

o user (a catch-all for whatever reason you want to use it) -- light blue 

 ECO (Encyclopedia of Chess Openings) code 

 the date 

 the result 

 the number of moves in the main line  

 letter codes 
o A or a – a lot of or some arrows and/or colored squares 

o C or c – a lot of or some text commentary 

o F – correspondence chess 

o G – another game is referenced 

o I – critical positions 

o M – multimedia (sound, pictures, videos) 

o P – a starting position other than the normal chess starting position 

o R – a “repertoire” game 

o S or s – a lot of or some symbols 

o T or t – training (designated by *** in the ‘Notation’ window) 

o V or v – a lot of or a few variations 
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Database file structure: 

 
http://www.chessbase.com/support/support.asp?pid=148 
 

The first thing you'll need to understand is that any database in ChessBase format actually consists of multiple 
files. When you create a database in .CBH format, you'll notice that the program (ChessBase, Fritz, or one of the 
other playing programs) will ask you to name the .CBH file. This does not indicate that the whole database is 
stored in just that one file! The .CBH file stores just the header information from the games in the database; the 
annotations are stored in another file, the moves in yet another, each key is kept in its own file, etc.  

What this means is that when you make a backup of a ChessBase/Fritz database, you need to backup all the files 
that make up the database. A ChessBase/Fritz database in .CBH format is composed of a minimum of seven and 
as many as twenty separate files. If you backup or save just the .CBH file and try to open it later, you'll get 
squadoo -- the additional files are required.  

But ChessBase and the various playing programs we offer give you the option of bundling all of these files 
together into one unified archive file. This file ends in the extension .CBV and is an archive that stores the 
multiple database files into a single compressed file. This allows for easier copying to a storage medium (such as 
a CD or floppy disk) since you'll only need to copy one file instead of seven to twenty of them.  

Archiving a database is really easy. In ChessBase 8, all you need to is single-click a database's icon to highlight 
it. Then go to the Tools menu, select "Database", and then "Backup database" from the submenu. A dialogue 
appears asking if you want the archive file to be "crypted" or "uncrypted". This is just a fancy way of asking if 
you'd like to password-protect your archive file. If you protect it with a password, the program will prompt you to 
enter that password when you try to open that archive file. If you can't provide the password, you'll not be able to 
access the database -- and there's no "back door" that lets some programmer or techie from ChessBase open the 
archive for you in case you forget the password. So unless you're a top GM who needs to keep his "secret 
analysis" secret, I strongly recommend against using the "crypted" option. If you forget your password later, 
you're sunk -- there is no way to get into a crypted archive file without the password.  

… 

a .CBV file always uncompresses into the same folder it's currently located in. 

… 

If you're very quick on the uptake, you've already spotted the danger of storing a .CBV file in the same folder as 
the original database from which it was created. If you should accidentally select that .CBV file when accessing 
File/Open/Database, you'll accidentally overwrite your current database with a previously archived version. This 
can be very bad, especially if you're not in the habit of making frequent backups. I once talked to a user who had 
created a .CBV file in the same folder as the original database, manually added a few hundred games to that 
database over the next few weeks, then accidentally selected the .CBV file from the "Open Database" dialogue. 
The .CBV file uncompressed and overwrote his database with the last version he'd archived. In an instant, his few 
hundred new games were gone, with no way of getting that work back.  

 

Sorting the Games in Your Database by Date: 

 

Sadly, there’s no easy way to do this. This functionality is not included with Fritz in order to coerce people into 

buying ChessBase. The workaround for this is to manually copy and paste the games from the unsorted source 

database in the correct order into a sorted target database. To make this easier I recommend that your archive 

database only contain games for a particular year, and your working databse only contain games for the current 

month (smaller, chronologically based databases will be easier to sort using this workaround). 

 

 

Replacing Games in Your Database: 

 
http://www.chessbase.com/download/pdf/InstructionsToChessBase10.pdf 
 
You can replace any game in any database by any other game. Load or enter the new game. Open the target 
database and right-click the old game to be replaced. In the right-click-menu call Edit -> Replace with... 

 

http://www.chessbase.com/support/support.asp?pid=148
http://www.chessbase.com/download/pdf/InstructionsToChessBase10.pdf
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Database Keys: 

 

Note that in this discussion a better word for ‘key’ might be ‘category’. The word ‘key’ has specific meanings 

pertaining to databases that just don’t seem to fit here. 

 

 

http://www.chesscafe.com/text/lopez12.pdf 

 

A way of classifying your database involves the use of keys. A ‘key’ is just another word for ‘index.’ 

Fritz can utilize pre-created index files to classify games according to the openings used in them. There 

are two ways to get started on this process. In the first, just click each tab at the top of the game list. 

You’ll see four buttons at the center of your game list screen: 

 

Install Big Key – this will install a huge comprehensive index of all 

ECO codes, as well as various numbered sub-variations within each 

code (as they appear in ECO itself). This key is intended for use 

with large databases containing many thousands of games. For a 

small personal database, this big key is too much of a good thing – 

the key files will require many more times the amount of hard drive 

space than is taken up by your actual game files. 

 

Install Small Key – the key that’s installed after clicking this button 

is well-suited for use with smaller databases. It is a less 

comprehensive, more general opening key; for example, instead of 

the dozens of keys and sub-keys that you’d get for the Sicilian 

Defense by using the big key, you’ll get a main key called “Sicilian 

Defense” and double-clicking on it will display a small list of subkeys 

based on the most commonly played Sicilian variations. 

 

Select key – this will bring up the Windows File Select dialogue that 

will allow you to select an opening key from any drive or folder. 

This is useful for installing a specialized key, such as one you’d find 

on a separate ChessBase training or database CD. 

 

Install empty key – this will install a “blank” key without any index 

categorizations. This option isn’t recommended unless you also have 

the ChessBase database program, since Fritz on its own doesn’t give 

you the option to create your own key indexes. 

  

http://www.chesscafe.com/text/lopez12.pdf
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Another way to do this is to use the ‘Install Key’ option from the ‘Key Functions’ button on the 

‘Database’ tab of the ‘Database’ window: 

 

The ‘Select key’ button has been replaced by a ‘Browse’ button in this view. 

 

 

 
 

 

 

Note that you’ll sometimes want to reclassify games. As you add games to your database, you’ll find 

that the new additions aren’t sorted into index classifications in the keys. So, after adding new games to 

your database, go to the Tools menu, select ‘Classification,’ and then: 

 

‘Classify all keys’ to reclassify all keys on the current tab (Openings, Themes, etc.) 

‘Whole Database’ to reclassify all keys in the entire database 

‘This key’ to reclassify the highlighted key in the current tab 

 

http://www.chessbase.com/workshop2.asp?id=1754 

 

Be very careful when reclassifying. If you’ve manually classified a game into a particular key, 

reclassifying that key will delete all of the manual classification you’ve done. 

 

 

 
  

http://www.chessbase.com/workshop2.asp?id=1754
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Notation Window: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

The ‘Notation’ window can be customized by left clicking the ‘Application Menu’, then left clicking ‘Options’, 

then left clicking the ‘Clocks+Notation’ tab: 

 

  

 

The ‘Notation’ window looks like this: 

 

 
 

 The black highlight is the move that’s being displayed on the board. 

 The black text is the move that was made. 

 The purple number is the clock data (in this example it’s the amount of time that was spent deciding on 

that move, but it can also be just the time shown on the clock). 

 The blue text is the evaluation of the position expressed as evaluation/depth (where evaluation, depth, 

and ‘#’ are the same metrics that are used in the ‘Main Engine’ window, and are explained in that 

section of this document). You only see this blue text if you look at a game you’ve played against Fritz 

and then saved, or if you’ve done a ‘Blunder Check’ on any saved game. 
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Main Engine Window: 
(CTRL + Left Click here to jump back to Table of Contents) 
 
 

  

 

 
Fritz 12 the chess engine being used 

Stop stop analysis 

+ increase the maximum number of mainlines that will  be considered (see the Search Options page of this 

document) 

- decrease the maximum number of mainlines that will  be considered (see the Search Options page of this 

document) 

configuration button brings up the ‘Search Options’ window (see the Search Options page of this document) 

CPU button how many CPUs to use (only useful with the Deep Fritz version) 

yellow lamp turns red when the engine finds something dramatic (i.e. when the value suddenly rises or falls 

dramatically). An arrow pointing up or down denotes a ‘fail high’ or ‘fail low’, which simply means that 

the computer has discovered something good or bad in the position but doesn't yet know what it is. 

=+(-0.55) 

evaluation 

the value of the best move expressed in terms of centipawns (positive always means white is better, 

negative always means black is better).   =+(-0.55) means Black has a 1/2 pawn (0.55 centipawn) 

advantage materially and/or positionally. A ‘#’ means a forced checkmate is possible in the number of 

moves indicated (explained later herein). A ‘B’ means the move was taken from the Openings book 

(explained later herein). 

Depth=19/46 all main lines analyzed at least 19 plys (half moves) deep, some main lines as many a 46 plys deep 

6.d3(3/34) what move is currently being analyzed, and it’s the 3
rd

 of 34 legal moves 

397 mN how many nodes have been analyzed (k means 1,000 and m means 1,000,000) 

0:03:35 how long has the engine been working on this move 

rows 1-4 the 4 lines being analyzed 

6.d3 the current line being analyzed 

 

  



Fritz 12 Quick Guide   Page 23 of 49  

A ‘#’ in the ‘Main Engine’ window means there is a forced checkmate available in the number of moves 

indicated. In the following position, we see from both the ‘Main Engine’ window and the ‘Notation’ window 

that Black to move has a forced checkmate in three moves: 

 

  

     

 

 

 

A ‘B’ in the ‘Main Engine’ window means that Fritz took the move from the Openings Book and Fritz didn’t 

spend any time actually calculating the move. 
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‘Search Options’ window (you get here by left clicking the configuration button in the Main Engine window): 

 

 
    

 Number of mainlines is the same setting as is controlled by the + and – buttons in the ‘Main Engine’ 

window. 

 ‘Evaluation window’ checkbox controls whether or not the ‘Evaluation’ window is displayed in the 

‘Main Engine’ window 

 the lower right box is tricky and  unlabeled. It’s basically how bad a line has to be in order for Fritz to 

not even analyze it. In the above screenshot, Fritz will analyze no more than the 2 best lines, and it 

won’t analyze the second best line if it’s worse than the main line by more than half a pawn (50 

centipawns). 
 

http://www.chesscentral.com/Rybka_3_Chess_Software_Report_a/Rybka_Chess_Playi_Software_P4_a/150.htm 

This allows you to set a margin, measured in 1/100ths of a pawn, within which secondary, tertiary, etc. variations must 
fall within (compared to the main variation) to be displayed in the Engine Analysis window. 

Let's explain this further by using an example. In the illustration above you can see the number of variations has been 
set at ‘2’ and the margin has been set at ‘50’. This means that two lines of play may be displayed, the best variation and 
the second-best line. But a second-best variation will be displayed only if it's evaluated as being worse than the main 
variation by a half-pawn (‘50’) or less; variations which are worse by more than a half-pawn won't be displayed at all.  

 

‘Next Best’ (you get here by right clicking in the ‘Main Engine’ window): 

 

 
 

 ‘Next Best’ - Fritz will stop analyzing the best move and focus on the next best move 

 ‘Search Better’ – see the following explanation 

 ‘Search Clearly Better’ – see the following explanation 
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http://www.chesscentral.com/Rybka_3_Chess_Software_Report_a/Rybka_Chess_Playi_Software_P4_a/150.htm  

A second analysis option works somewhat ‘in reverse’ of the dialogue we've just discussed. ‘Find better/Clearly better 
move’ also searches for alternate lines of play, but instead of displaying lines which are x/100ths of a pawn worse than 
the main line, this feature searches for moves which are x/100ths of a pawn better.  

I can hear you asking ‘Wait a minute - if the engine is already displaying the best line of play (in its estimation), how can 
it display something better?’ Here's a scenario to illustrate how this feature works.  

Let's say that you're looking at a position and Rybka's analysis of a possible continuation. The engine is showing (as 
usual) the best line of play it's discovered so far. But you have a sneaking suspicion that there might be a better 
variation, which Rybka would find if it could look far more deeply at some possibilities it rejected early in the present 
search (perhaps a material sacrifice which was rejected because a short search did not reveal an advantage). So you 
right-click in the Engine Analysis pane, select ‘Next best’, and then ‘Properties’ from the submenu. You'll see the 
following dialogue: 

 

 

This again allows you to set a margin, but this time the line displayed must be x/100ths of a pawn better than the 
previously-displayed main line (x being the value that you type into this dialogue's field). Click ‘OK’ and when you 
activate the ‘Find better’ or ‘Clearly better’ dialogue, the software will cease to display the previous main line and will 
not display a variation in the Engine Analysis pane unless the engine finds a line which is better than the previously 
displayed main line by the value you set. Because the engine is no longer analyzing the previous main line and is 
instead searching for (sometimes radical) alternatives, it will look very deeply quite quickly and display any tactical 
solutions it might otherwise have considered ‘unpromising’ and thus had pruned from the search tree early on.  

Now I'll warn you straight away that this feature won't turn up a better move unless one actually exists, and this won't 
be the case in the majority of positions. But when it does find such a move, you might be blown away by the result. In 
fact, the programmers suggest setting a high value in this feature's dialogue in order to find any truly spectacular 
alternative variations which might lie hidden in the position.  

 

The difference between ‘Search Better’ and ‘Search Clearly Better’ is that with ‘Search Clearly 

Better’ you can define the exact amount of ‘better’, in terms of centipawns (1/100ths of a pawn). 

 

 

 

To demonstrate all of this, Look at this position (in FEN notation) from a real game between 

William James Lombardy and Robert James Fischer which took place in New York, NY, USA, on 

December 19, 1960: 

 

8/pp4pp/4k3/3rPp2/1Pr4P/2B1KPP1/1P6/4R3 b 

 

Fritz 12 cannot find Mr. Fischer’s elegant and winning moves unless you tell it to ‘Search Clearly 

Better’: 

 

1. ... Rxc3+ 2.bxc3 Rxe5+ 3.Kd2 Rxe1 4.Kxe1 Kd5 and wins 
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‘Lock Engine’ (you get here by right clicking in the ‘Main Engine’ window): 

 

 
 

 ‘Lock Engine’: Normally, in analysis mode, the engine automatically follows the board. However, you 

can ‘lock’ it to a particular position and then move around the game without the engine following. Click 

again to unlock. 
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Evaluation Profile Window: 
(CTRL + Left Click here to jump back to Table of Contents) 

     

 
 

The tick at the top changes to black after a white move, and changes to blue after a black move 

 

 Histogram bars above the centerline mean White has an advantage. 

 Histogram bars below the centerline mean Black has an advantage. 

 When a human plays against the computer, the human is green and the computer is red. 

 When analyzing a game, White is green and Black is red. 

 Yellow can be shown above or below the centerline and means the histogram bar goes beyond the scale of 

the window, which is on the right hand side. 

 

The above evaluation profile means this: 

 

On move 1, White moved and got almost a ½ pawn advantage 

On move 1, Black moved and nullified White’s advantage 

 

On move 2, White moved and got a full ½ pawn advantage 

On move 2, Black moved and White’s advantage fell to just a ¼ pawn 

 

On move 3, White moved and White kept the ¼ pawn advantage 

On move 3, Black moved and White kept the ¼ pawn advantage 

 

On move 4, White moved and White kept the ¼ pawn advantage 

On move 4, Black moved and Black got a ½ pawn advantage 

 

On move 5, White moved and Black got a full pawn advantage 

On move 5, Black moved and Black kept a full pawn advantage 

 

On move 6, White moved and Black’s advantage fell to a ½ pawn 

Black has not yet made its 6
th

 move 

 
If you perform a ‘Blunder Check’ on a game and store the ‘Evaluation’, then that will be used to populate the 

‘Evaluation Profile’ window whenever you open that game from the database. When you open a game that has 

no evaluation data stored with it, you can build the evaluation profile automatically by pressing the ‘*’ key on 

your numeric keypad (not the ‘*’ above the ‘8’ key, but the ‘*’ that’s on the right hand side of a full keyboard, 

or the one that’s on the ‘p’ key on a laptop) and let the computer step through the game move by move while 

doing ‘Infinite Analysis’.  
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Setting Up a Position: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

To set up a position from which to play or analyze, left click the ‘Position Setup’ button on the ‘Insert’ menu. 
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Analyzing a Completed Game: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

The overview of how to use Fritz to analyze a completed game: 

 

1. Enter the game into Fritz and save it to a database. 

2. Enter your annotations immediately after entering the game so you remember what you were thinking 

before you see what Fritz suggests. I strongly recommend enclosing your commentary in curly brackets, 

‘{‘ and ‘}’, so that you can easily distinguish your commentary from the commentary that Fritz writes 

(note, however, that Fritz uses ‘{#}’ to insert diagrams into the game’s notation). When you’re done, 

save the game with  your annotations to a database. 

3. From the ‘Database’ window, have Fritz do a ‘Blunder Check’ and choose to NOT ‘Erase old 

annotations’. Doing a ‘Blunder Check’ before a ‘Full Analysis’ seems to create a more readable output 

insofar as the placement of Fritz’s commentary relative to the moves and the numerical evaluations. 

4. From the ‘Database’ window, have Fritz do a ‘Full Analysis’ and choose to NOT ‘Erase old 

annotations’. 

 

Note that both a ‘blunder check’ and a ‘full analysis’ allow you to set a threshold for evaluation, so neither 

analysis method is ‘superior’, it’s just that ‘blunder check’ gives a numerical analysis, and ‘full analysis’ gives 

natural language commentary. 

 

Note that doing ‘Blunder Check’ and ‘Full Analysis’ from the ‘Database’ window gives you the option of 

saving the game to the database by replacing the existing version of the game, or appending a new version of 

the game to the database. If you do ‘Blunder Check’ or ‘Full Analysis’ for a game that you entered into Fritz but 

didn’t save to a database, neither the replace nor append option is available, so you’ll have to remember to save 

the game to a database when you’re done with the ‘Blunder Check’ or ‘Full Analysis’, else you’ll lose all of the 

analysis when you change games or close Fritz. 

 

Note that ‘Deep Position’ analysis is not available from the ‘Database’ window. See the ‘Deep Position 

analysis’ section of this document to learn more about how to use that. 

 

http://www.chesscafe.com/text/lopez04.pdf 

 

 

  

http://www.chesscafe.com/text/lopez04.pdf
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Enter the game into Fritz: 

First, either turn the chess engine off from the ‘Engine’ tab or by pressing ‘Shift’ + ‘Ctrl’ + ‘M’ , or go into 

‘Infinite Analysis’ mode (this prevents Fritz from actually trying to play against you while you enter the moves 

of the game into the computer): 
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Next, from the ‘Home’ tab enter your game into Fritz. 

 

 you can manually enter the game by moving the pieces in Fritz 

 you can paste a game using PGN (Portable Game Notation) 

 
[Event ‘King's Island Tournament’] 

[Site ‘King’s Island Resort, Mason, OH, USA’] 

[Date ‘2010.11.12’] 

[Round ‘1’] 

[White ‘Smith, Joe’] 

[Black ‘Jones, Mark’] 

[Result ‘0-1’] 

1. f3 e6 2. g4 Qh4# 0-1 

 

 you can paste a starting position and moves using a combination of PGN and FEN (Forsyth–Edwards 

Notation) 

 
[Event ‘King's Island Tournament’] 

[Site ‘King’s Island Resort, Mason, OH, USA’] 

[Date ‘2010.11.12’] 

[Round ‘2’] 

[White ‘Smith, Joe’] 

[Black ‘Doe, Jane’] 

[FEN ‘8/6B1/8/4pp1p/7P/2b2P2/4k1K1/8 b’] 

[Result ‘0-1’] 

1... e4 2. fxe4 f4 0-1 

 

 

 

After you enter the game into Fritz, save the game to a database. 

 

Add your own annotations: 

Next, enter your comments into the notation pane by right single clicking each move and selecting ‘Text Before 

Move...’ or ‘Text After Move...’. I suggest enclosing your commentary in curly backets, ‘{‘ and ‘}’, so that you 

can easily distinguish your commentary from the commentary that Fritz writes. It’s important to enter your own 

commentary before Fritz analyzes your game so that you can remember what you were actually thinking for 

each move. After you’ve entered your annotations, save the game with your annotations to a database.  
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Have Fritz do a ‘Blunder Check’: 

From the ‘Database’ tab of the ‘Database’ window, do a ‘Blunder Check’. Doing a ‘Blunder Check’ before a 

‘Full Analysis’ seems to create a more readable output insofar as the placement of Fritz’s commentary relative 

to the moves and the numerical evaluations. ‘Blunder Check’ is much, much more than just a blunder check, 

and it will add detailed variations to your game as well as numerical evaluations (numerical evaluations are 

described in the ‘Notation Window’ section of this document). Be sure to clear the checkbox for ‘Erase old 

annotations’. 

 

 ‘Time’ is not well labeled, but it’s the minimum number of seconds Fritz will spend analyzing each 

move. Fritz will always spend more time than the minimum, but it stays as close as it can to that 

minimum as it can given the complexity of the analysis. I recommend 60 as minimum, 120 as medium, 

180 as maximum. 

 ‘Threshold’ is the number of centipawns of improvement that are required in order for Fritz to display a 

variation. 

  ‘Annotate as text’ will make Fritz display variations as simple text, but ‘Annotate as variations’ will 

make Fritz display variations that will actually move the pieces on the board when you click on the 

variations. 

 ‘Write full variations’ will make Fritz write out the full variation instead of just the first move of it. 

 Be sure to clear the checkbox for ‘Erase old annotations’. 

 ‘Training’ will include training questions which show up in the notation pane as ‘***’ (I think the 

training questions are pretty useless). 

 ‘Check main line’ will make Fritz analyze the main line. 

 ‘Check variations’ will make Fritz analyze the variations. 

 ‘Threshold’ is the number of centipawns of improvement that are required in order for Fritz to display a 

variation. 
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Have Fritz do a ‘Full Analysis’: 

From the ‘Database’ tab of the ‘Database’ window, do a ‘Full Analysis’. Full analysis will add ‘natural 

language’ commentary and improved variations to your game. Be sure to clear the checkbox for ‘Erase old 

annotations’. 

 

 ‘Calculation Time’ – I recommend a minimum of 60 seconds per move, a maximum of 120 minutes per 

game. 

 ‘Graphical’ will include arrows and such on the board. 

 ‘Training’ will include training questions which show up in the notation pane as ‘***’ (I think the 

training questions are pretty useless). 

 Be sure to clear the checkbox for ‘Erase old annotations’. 

 ‘Threshold’ is the number of centipawns of improvement that are required in order for Fritz to display a 

variation. 

 ‘Last move’ is the highest move of the game you want analyzed. Being that Fritz analyzes games 

backwards, it will begin its analysis on the last move and work toward the opening. Note, however, 

choosing ‘1’ for ‘Last move’ will cause the entire game to be analyzed. 
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You can analyze multiple games in a single batch from the ‘Database’ window. Just highlight the batch of 

games you want to analyze (by using shift & left click, or control & left click) and hit the ‘Full Analysis’ button 

as previously discussed, then the ‘Blunder Check’ button as previously discussed. 

 

NOTE: I’ve found a bug in Fritz 12 (Oct 13 2010) whereby not all of the selected games are really selected, and 

this makes doing bulk analysis difficult. So select the games you want to analyze, then minimize the ‘Database’ 

window, then restore the ‘Database’ window, and then all of the games that appear highlighted are indeed truly 

selected. 
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‘Deep Position Analysis’: 

Deep Position Analysis is very good for getting deep and detailed analysis of a critical position and the next 

four moves. This is especially useful when a game is adjourned and you want coaching, or when there was a 

clear turning point on which you want coaching from a completed game. 

 

‘Deep Position Analysis’ cannot be done from the ‘Database’ window, but only from the ‘Analysis’ tab. 

 

 
 

 

‘Deep Position Analysis’ parameters: 

 

 
 

 Time/Depth 

o Total time - the time Fritz will spend on the entire ‘Deep Position Analysis’ 

o Time - the time Fritz will spend on each move of the ‘Deep Position Analysis’ 

o Depth - the depth at which you want Fritz to analyze each move 

o plus (root) - extra seconds or move depth used when analyzing the root position (see the 

following two diagrams for what ‘root’ means) 

o I recommend using the ‘Total time’ option and just giving Fritz as much time as  you can afford 

o On a slow or busy computer, ‘Depth’ will oftentimes give better results 
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 Branching 

o the values for ‘Branching in 1
st
/2

nd
/3

rd
/4

th
 move’ must be between 1 and 99 (as of 7/9/2011 you 

can use the GUI arrows to set a value between 1 and 99, but you can key in a 0 and the program 

will crash) 

o branching is simply the number of best next moves that are analyzed at each specific point, 

taking into account the ‘Evaluation window’ and ‘Cut bad lines’. The following two diagrams 

give visual examples of what Branching is. 

 Length of variations - the maximum length of the analyzed and displayed variations 

 Evaluation window - how much worse a variation has to be than the best variation in order for Fritz to 

not even analyze or display it 

 Cut bad lines - Fritz will not analyze or display variations determined by the Alpha-Beta algorithm to be 

bad 
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Following is a sample of the output from ‘Deep Position Analysis’ with White to move on 9 as the root: 
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In older versions of Fritz 12 there was a ‘Copy to notation’ option when you right single clicked in the ‘Main 

Engine’ window. However, as of 7/9/2011 the ‘Deep Position analysis’ is automatically put into the ‘Notation’ 

pane once the analysis is complete. Thus, after ‘Deep Position Analysis’ completes, be sure to save or re-save 

the game or position into a database in order to preserve the analysis. Also, if you right single click inside the 

‘Main Engine’ window and choose ‘Clip analysis’ while the ‘Deep Position Analysis’ is running, you can clip 

the incomplete analysis to the Windows clipboard so you can paste it into some other application. 
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Annotation Symbols: 

 

http://www.chessville.com/misc/misc_codes_annosymbols.htm 

Symbol Means Also Written As 

1 - 0 White Wins   

0 - 1 Black Wins   

1/2 - 1/2 Draw   

+ Check ch. 

++ Double Check dbl. ch. 

dis. ch. Discovered Check   

O-O Castles Kingside   

O-O-O Castles Queenside   

# Checkmate   

! Good Move   

!! Very Strong or Brilliant Move   

? Mistake   

?? Blunder   

!? Interesting Move   

?! Dubious Move   

+- White has a Winning Advantage   

 

White has a Clear Advantage +/- 

 

White has a Slight Advantage +=  or  +/= 

= Equal Position   

~ Approximately Equal Position   

 

Unclear Position   

 

Black has a Slight Advantage =+  or  =/+ 

 

Black has a Clear Advantage -/+ 
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-+ Black has a Winning Advantage   

 

Compensation   

 

Counterplay   

 

Initiative   

 

Attack   

 

Zugzwang   

 

Only Move   

 

Development Advantage   

 

Space Advantage   

 

Zeitnot (Time Trouble)   

N Novelty   

RR Editorial Annotation   

 

Better is   

 

Worse is   

= Equivalent is   

 

With the Idea of   

 

Directed Against   

<< Queenside   

>> Kingside   

e.p. En Passant   

OTB Over the Board   

CC Correspondence Chess   

Ch. Championship   

M. Match   

OL Olympiad   

zt Zonal   
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izt Inter-zonal   

rpd Rapid Play   

sim Simultaneous   

jr Junior Event   

w Women's Event wom 

 

 

Colored Squares and Arrows: 

 

To add a green arrow hold down the ‘Alt’ key, click on the chess board and drag the mouse to the finish 

position.  

 

 
 

For yellow arrows use ‘Ctrl’ and ‘Alt’. 

 

 
 

For red arrows use ‘Shift’ and ‘Alt’. 

 

 
 

 

You can also highlight single squares using the steps above but only clicking once on a square. 
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Printing a Game: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

 

First adjust your ‘Page Setup’ preferences: 

 

 
 

The ‘Diagrams directly’ checkbox on the ‘Print games’ tab seems to cause the diagrams you’ve inserted into the 

game notation to be printed where they actually appear in the game notation, rather than where the prettiest 

formatting would put them. I haven’t yet fully confirmed this. 
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The ‘Flipped’ checkbox on the ‘Print Diagram’ tab causes the diagrams you’ve inserted into the game notation 

to be printed from Black’s perspective instead of White’s perspective (it flips the board). 

 

 
 

To get a print preview, just print the game and you’ll be taken to the ‘Print Preview’ tab from which you can 

send the preview to the printer, or close the preview. 
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Playing a Game Against Fritz: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

From the ‘Home’ tab, you can play games where Fritz plays at full strength and the only things you can change 

are your and its time controls, and the depth to which Fritz calculates. 

 

 
 

 

From the ‘Training’ tab, you can play games where you can granularly adjust the strength at which Fritz plays 

and the types of weaknesses it will have. 

 

 
 

 ‘Rated Game’ – use this if you want Fritz to estimate your chess strength rating 

 ‘Sparring’ – you can set Fritz from Very Easy to Really Hard, and make it point out wins or not 

 ‘Friend mode’ – you set your own handicap in centipawns, and Fritz will adjust its strength 

automatically and give you a new centipawn handicap at the end of the game 

 ‘Handicap and Fun’ – you can granularly set the strengths, weaknesses, and rating of Fritz 

 ‘Handicap Position’ – you set your handicap in terms of free moves and pieces 

 

I’ve read that in handicap mode, the openings book is switched off, but I haven’t confirmed this. 
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Training Under Fritz: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

Fritz has training videos which are accessible from the ‘Chess course’ option of its startup screen. 

 

 
 

 

Fritz also has training features which are accessible from the ‘Training’ tab. 
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Making Fritz Compete Against Itself: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

 

The Shootout is a tool for players who want to see how a particular position might be handled using best play 

by both sides (deep position analysis is also a tool for this). 
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Openings Book: 
(CTRL + Left Click here to jump back to Table of Contents) 
 

 

The Fritz DVD has the Fritz 12 Openings book (Fritz12.ctg) on it. If you start Fritz with its DVD in your optical 

drive, then the openings book will be available to Fritz. Running the openings book from your optical drive is 

slow, noisy, takes a lot of power, and generates a lot of heat. As such, it’s better to copy the openings book to 

your hard disk. Do this by left clicking ‘Copy tree to hard disk’ from the ‘Analysis’ tab, and then accept the 

defaults. 

 

 

 
 

 

If you copy the Fritz 12 Openings book to your hard disk, Fritz will learn from its wins and losses and modify 

the openings book by assigning weights to moves. You can reset those weights back to their original settings by 

choosing ‘Reset Weights’ in the ‘Openings Book’ pull down menu on the Analysis tab. Note that resetting the 

weights does not change the color of any manually altered moves back to their original colors (this will be 

explained later in this section). 

 

If you copy the Fritz 12 Openings book to your hard disk, you can manually customize the Fritz 12 Openings 

book. 
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The ‘Openings Book’ tab in the Notation window: 

 

 

 
 

 

 DFritz12.ctg – the name of the Openings book being used 

 Green moves are commonly played by Fritz 

 Black moves are occasionally played by Fritz 

 Blue moves are seldom played by Fritz 

 Red moves are never played by Fritz (provided that the Book options are set to tournament -- Book options 

are described later in this section) 

 N – the number of times this move was used in the games contained in the Openings book 

 % – the success of the move expressed as a percentage 

 Av – the average ELO rating of the players who used this move 

 Perf – the ELO performance that would be reached if one were to play this move all the time 

 Fact – the weight Fritz has assigned to this move by actually playing it, or the weight manually assigned to 

this move by you 

 Prob – the probability that Fritz will play this move, without taking the ‘Fact’ into consideration 

 [%] – the probability that Fritz will play this move, with taking the ‘Fact’ into consideration 

 

Green bar – the number of wins after this move was played 

Grey bar – the number of draws after this move was played 

Red bar – the number of losses after this move was played 
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Customizing the Openings Book: 

http://rybkaforum.net/cgi-bin/rybkaforum/topic_show.pl?tid=17792 

 

 To make a green or blue move red, right click on it and select ‘Don't play in tournament’. Red moves will 

never be played while the openings book options are set to ‘Tournament book’. Note that resetting the 

weights will not change the color back to its original. 

 To make a red move green, right click on it and select ‘Main Move’. Note that resetting the weights will not 

change the color back to its original. 

 To change the ‘Fact’ (i.e. the probability weight) of a move, right click it and choose ‘Change weight’, and 

set it between -125 (very unlikely to be played) and +125 (very likely to be played). This is what Fritz’s 

automatic book learning does (based on whether games are won or lost) but this is how you do it manually. 

Note that resetting the weights will change the weight back to its original value. 

 

 

‘Book options’: 

 

 
 

 

 ‘Tournament book’ – don’t use red moves 

 ‘Variety of play’ – high variety means Fritz will choose blue and green moves, not just the strong green 

moves 

 ‘Influence of learn value’ – how strongly does the weight (the ‘Fact’) influence the move choice 

 ‘Learning strength’ – how quickly will Fritz change the weights based on its wins and losses 

 ‘Optimize’ – set Variety, Influence, and Learning to original, optimal values 

 ‘Normal’  – set Variety, Influence, and Learning to normal values 

 ‘Handicap’  – set Variety, Influence, and Learning to handicap values 

 

 

For training I recommend turning off ‘Tournament book’ and setting ‘Variety of play to maximum’. This will 

cause Fritz to throw all sorts of opening moves at you, not just the ones you’ll see from strong tournament 

players. 

 


